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KATA PENGANTAR

Modul dengan judul “Mengoperasikan Software Pengolah Gambar Raster

(digital Imaging) “ merupakan bahan ajar yang digunakan sebagai

panduan praktikum peserta diklat Sekolah Menengah Kejuruan (SMK)

untuk membentuk salah satu bagian dari kompetensi bidang keahlian

Teknik Informasi dan Komunikasi pada Program Keahlian Multimedia.

Modul ini menguraikan tentang cara mengoperasikan software pengolah

gambar raster (digital Imaging) dengan menggunakan bantuan program

(software) Photoshop 6.0. dijalankan dengan menggunakan system

operasi Windows yang sudah dikenal secara luas oleh pengguna

komputer.

Modul ini terkait dengan modul lain yang membahas tentang Mengopera-

sikan Periferal Grafis (HDW.OPR.105.(1).A), Melakukan Entry Data [Grafis]

dengan menggunakan Image Scanner (DTA.OPR.102.(1).A, Level 1), dan

Mengoperasikan Software Pengolah Gambar Vektor (Digital Illustration)

(SWR.OPR.408.(1).A)

Oleh karena itu, sebelum menggunakan modul ini peserta diklat

diwajibkan telah mengambil modul tersebut. serta pengetahuan dasar

tentang pengoperasian komputer

Yogyakarta, Nopember 2004

Penyusun

Tim Fakultas Teknik

Universitas Negeri Yogyakarta
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Keterangan :

A HDW.OPR.105.(1).A Mengoperasikan periferal untuk
pembuatan grafis

B DTA.OPR.102.(1).A Melakukan entry data [grafis] dengan
menggunakan Image scanner (Level 1)

C SWR.OPR.408.(1).A Mengoperasikan software pengolah
gambar vektor (digital illustration)

D SWR.OPR.409.(1).A Mengoperasikan software pengolah
gambar raster (digital imaging)

E HDW.OPR.106.(1).A Mengoperasikan periferal web

F DTA.OPR.102.(2).A Melakukan entry data [web] dengan
menggunakan Image scanner (Level 2)

G SWR.OPR.414.(1).A Mengoperasikan software web design
H SWR.OPR.415.(1).A Mengoperasikan software 2D animation
I SWR.OPR.413.(1).A Mengoperasikan software FTP
J HDW.OPR.107.(1).A Mengoperasikan periferal multimedia

K DTA.OPR.102.(2).B
Melakukan entry data [multimedia]
dengan menggunakan Image scanner
(Level 2)

L SWR.OPR.416.(1).A Mengoperasikan software multimedia

M SWR.OPR.407.(2).A Mengoperasikan software presentasi
(Level 2)

N HDW.OPR.108.(1).A Mengoperasikan periferal animasi 3D

O SWR.OPR.417.(1).A Mengoperasikan software basic 3D
animation (Level 1)

P SWR.OPR.418.(2).A Mengoperasikan software model 3D
animation (Level 2)

Q HDW.OPR.109.(1).A Mengoperasikan periferal perekam suara
R HDW.OPR.110.(1).A Mengoperasikan periferal perekam gambar
S SWR.OPR.419.(1).A Mengoperasikan software digital audio
T SWR.OPR.420.(1).A Mengoperasikan software digital video
U SWR.OPR.421.(1).A Mengoperasikan software visual effects
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PERISTILAHAN/GLOSSARY

Pixel  = kumpulan titik

Resolusi = jumlah pixel per centimeter

intensitas = warna yang dimiliki oleh gambar

render = filter yang digunakan untuk efek tiga dimensi

layer  = suatu lapisan untuk proses menggambar
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BAB I

PENDAHULUAN

A. DESKRIPSI JUDUL

Mengoperasikan Software Pengolah Gambar Raster merupakan modul

teori dan atau praktikum yang membahas dasar-dasar menggambar

dengan software pengolah gambar Raster. Software yang dapat

digunakan untuk mengolah gambar raster ada bermacam-macam,

yang masing-masing selalu dikembangkan oleh pembuatnya. Dalam

modul ini, pengolahan gambar raster menggunakan software

Photoshop 6.0.

Modul ini terdiri dari 4 (empat) kegiatan belajar, yaitu (1)

Mempersiapkan software pengolah gambar Raster (Photoshop 6.0), (2)

Membuat objek baru dengan menggunakan tulisan tangan (free-hand),

(3) Menerapkan efek visual pada objek gambar. Dengan menguasai

modul ini diharapkan peserta diklat mampu mempersiapkan software

Photoshop, membuat objek baru, menerapkan efek visual, dan

membuat animasi.

B. PRASYARAT

Kemampuan awal yang dipersyaratkan untuk mempelajari modul ini

adalah :

1. Peserta diklat menguasai pengetahuan pengoperasian komputer

dasar

2. HDW.OPR.105.(1).A Mengoperasikan Periferal Grafis.

3. DTA.OPR.102.(1).A Melakukan Entry Data [Grafis] dengan

menggunakan Image Scanner (Level 1).
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4. SWR.OPR.408.(1).A Mengoperasikan Software Pengolah Gambar

Vektor (Digital Illustration)

C. PETUNJUK PENGGUNAAN MODUL

1. Petunjuk Bagi Siswa

Siswa diharapkan mampu berperan aktif dan berinteraksi dengan

sumber belajar yang mendukungnya, karena itu harus diperhatikan

beberapa hal sebagai berikut :

a. Langkah – langkah Belajar

Modul ini berisi materi mengenai kompetensi Mengoperasikan Software

Pengolah Gambar Raster (Photoshop ) dengan program aplikasi

Photoshop 6.0, oleh sebab itu perlu diperhatikan beberapa hal agar

peserta diklat lebih berkompeten dan professional, yaitu :

1) Apa yang harus dikerjakan pertama kali dalam Mengoperasi-kan

Software Pengolah Gambar Raster (Photoshop ) dengan program

aplikasi Photoshop 6.0 ?

2) Bagaimana cara : mempersiapkan software Photoshop, membuat

objek baru, menerapkan efek visual, dan membuat animasi ?

3) Apakah sudah sesuai prosedur pengoperasian software pengolah

gambar Raster (Photoshop 6.0)?

b. Perlengkapan yang Harus Disiapkan

Untuk menunjang kelancaran tugas yang akan Anda lakukan, maka

siapkan seluruh perlengkapan yang diperlukan sesuai dengan jenis

tugas pada masing-masing kegiatan pemelajaran.
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c. Hasil Pelatihan

Anda akan mampu melakukan tugas/pekerjaan mengoperasikan

software pengolah gambar Raster (Photoshop 6.0) sesuai dengan

prosedur pengoperasian dan membuat obyek-obyek gambar Raster

yang dikehendaki.

2. Peran Guru

Guru yang akan mengajarkan modul ini hendaknya mempersiapkan diri

sebaik-baiknya yaitu mencakup aspek strategi pemelajaran,

penguasaan materi, pemilihan metode, alat bantu media pemelajaran,

dan perangkat evaluasinya.

D. TUJUAN AKHIR

Setelah mempelajari modul ini, peserta diklat diharapkan kompeten

dan professional melakukan tugas/pekerjaan Mengoperasikan Software

Pengolah Gambar Raster (Photoshop 6.0).
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E. KOMPETENSI

Kompetensi   : Mengoperasikan software pengolah gambar Raster (Photoshop 6.0)

Kode   : SWR.OPR.409.(1).A

Durasi pemelajaran   : 112 Jam @ 45 menit

A B C D E F GLEVEL KOMPETENSI KUNCI
2 2 2 3 2 2 3

KONDISI KINERJA

1. Dalam melaksanakan unit kompetensi ini harus didukung dengan tersedianya:
§ Software pengolah gambar raster (digital imaging) sudah terinstalasiasi
§ User manual software pengolah gambar raster (digital imaging) yang digunakan
§ SOP yang berlaku di perusahaan
§ Peralatan dan instrumen yang terkait dengan pelaksanaan unit kompetensi ini

2. Unit Kompetensi yang harus dikuasai sebelumnya:
§ HDW.OPR.105.(1).A Mengoperasikan Periferal Grafis
§ DTA.OPR.102.(1).A Melakukan Entry Data [Grafis] dengan menggunakan Image Scanner (Level 1)

§ SWR.OPR.408.(1).A Mengoperasikan Software Pengolah Gambar Vektor (Digital Illustration)
3. Pengetahuan yang dibutuhkan:
§ Pengoperasian Komputer
§ Pengoperasian Sistem Operasi sesuai dengan Instruction Manual
§ Objek gambar dan karakteristiknya, serta komposisi gambar dan warna
§ Free-hand drawing
§ On-site training sesuai dengan software yang digunakan
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MATERI POKOK PEMELAJARAN
SUB KOMPETENSI KRITERIA KINERJA LINGKUP BELAJAR

SIKAP PENGETAHUAN KETERAMPILAN
1. Mempersiapkan

software pengolah
gambar raster
(digital imaging)

§ Software digital
imaging telah
terinstalasi dan
dapat berjalan
normal

§ User manual
software digital
imaging sudah
disediakan dan
dipahami

§ Perangkat komputer
sudah dinyalakan,
dengan sistem
operasi dan per-
syaratan sesuai
dengan Installation
manual dan SOP
yang berlaku

§ Pengenalan
software digital
imaging

§ Mengamati
proses aktifasi
sistem operasi
dan software
digital imaging
dengan seksama

§ Menjelaskan fungsi
software digital
imaging

§ Menyalakan
komputer sesuai
dengan Installation
manual dan SOP

§ Menjalankan
software digital
imaging sesuai
prosedur. Contoh:
Adobe Photoshop,
Corel Photopaint

§ Software digital
imaging dijalankan.
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MATERI POKOK PEMELAJARAN
SUB KOMPETENSI KRITERIA KINERJA LINGKUP BELAJAR

SIKAP PENGETAHUAN KETERAMPILAN
2. Membuat objek

baru dengan
menggunakan
tulisan tangan
(free-hand)

§ Objek gambar dan
tools raster dikenali

§ Objek-objek baru
dibuat dengan
menggunakan
tulisan tangan/ free-
hand.

§ Objek free-hand
dihaluskan dengan
menggunakan efek-
efek penghalus
(smooting).

§ Objek free-hand
diintegra-sikan
dengan objek-objek
dasar gambar
lainnya.

§ Pengenalan objek-
objek dan tools
raster

§ Teknik pembuatan
objek-objek baru
dengaan free-hand

§ Mengenali objek
gambar dan tools
raster dengan
cermat

§ Mengamati
proses
pembuatan
objek-objek free-
hand dengan
seksama

§ Mengidentifikasi
objek gambar dan
tools raster

§ Menjelaskan
proses pembuatan
objek-objek baru
dengan free-hand

§ Membuat objek-
objek baru dengan
free-hand

§ Menggunakan efek-
efek penghalus
dengan tepat

§ Mengintegrasikan
objek-objek free-
hand dengan objek
dasar lainnya
secara tepat

3. Menerapkan efek
visual pada objek
gambar

§ Efek-efek visual lanjut
dipa-hami dan
diaplikasikan, seperti:
penghalusan,
perbesaran,
pemecahan,
pengaburan.

§ Objek gambar lain
seperti foto, dapat
dimanipulasi dengan
menggunakan efek-
efek visual.

§ Efek-efek visual lanjut
§ Objek foto

§ Mencermati
implemen-tasi efek-
efek visual pada
objek dengan
cermat

§ Mengamati proses
mani-pulasi objek
foto dengan
seksama

§ Menjelaskan fungsi
efek-efek visual
dalam pengo-lahan
gambar raster

§ Menjelaskan proses
manipulasi objek-foto
dengan
menggunakan efek-
efek visual

§ Menggunakan efek-
efek visual lanjut
dengan tepat

§ Memanipulasi objek
foto dengan
menggunakan efek-
efek visual sesuai
model
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F. CEK KEMAMPUAN

Untuk mengetahui kemampuan awal yang telah Anda miliki, maka

isilah cek lis (√) seperti pada table di bawah ini dengan sikap jujur dan

dapat dipertanggungjawabkan.

Saya dapat
Melakukan

Pekerjaan ini
dengan

Kompeten

Sub Kompetensi Pernyataan

Ya Tidak

Bila

Jawaban

“Ya”

Kerjakan

1. Mempersiapkan
software
Photoshop 6.0

1. Menguasai dan
terampil membuka
dan menutup
software Photoshop
6.0 sesuai prosedur

Tes Formatif
1

2. Membuat objek
baru dengan
menggunakan
tulisan tangan
(free-hand)

1. Mengenal objek-
objek dan tools
raster

2. Dapat membuat
objek-objek baru
dengaan free-hand

Tes Formatif
2

3. Menerapkan efek
visual pada objek
gambar

1. Mengaplikasikan
Efek-efek visual
lanjut

2. Manipulasi Objek
foto

Tes Formatif
3
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BAB II

PEMELAJARAN

A. RENCANA PEMELAJARAN SISWA

Kompetensi : Mengoperasikan Software pengolah gambar Raster

Photoshop 6.0

Sub Kompetensi :

1. Mempersiapkan software Photoshop 6.0

2. Membuat objek baru dengan menggunakan
tulisan tangan (free-hand)

3. Menerapkan efek visual pada objek gambar

Jenis Kegiatan Tanggal Waktu Tempat
Belajar

Alasan
Perubahan

Tanda
Tangan

Guru
1. Mempersiapkan

software
Photoshop 6.0

2. Membuat objek
baru dengan
menggunakan
tulisan tangan
(free-hand)

3. Menerapkan efek
visual pada objek
gambar
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B. KEGIATAN BELAJAR

1. Kegiatan Belajar 1 : Mempersiapkan software Photoshop 6.0

a. Tujuan Kegiatan Pemelajaran

1) Peserta diklat mampu menyalakan komputer sesuai dengan

Installation manual dan SOP

2) Peserta diklat mampu membuka dan menutup aplikasi perangkat

lunak Photoshop 6.0 sesuai prosedur

b. Uraian Materi 1

1) Pendahuluan

Komputer didalam merepresentasikan gambar memiliki dua cara yaitu

dengan bitmap dan vektor grafik.

2)  Bitmap

Beberapa pengertian yang berhubungan dengan bitmap

Pixel

Jika kita melihat foto atau gambar yang ada di komputer maka gambar

tersebut sesungguhnya adalah kumpulan dari ribuan titik titik yang

sangat kecil dan tiap tiap titik tersebut memiliki warna tertentu. Titik titik

itulah yang umum dikenal sebagai pixel. Setiap pixel mempunyai satu

warna dan bergabung dengan pixel-pixel yang lain sehingga membentuk

suatu pola dan menghasilkan gambar. Gambar seperti ini  hampir tidak

mungkin dibuat oleh tangan manusia. Bisa dibayangkan betapa rumitnya

hanya untuk untuk membuat sebuah garis lurus, bila harus dilakukan

dengan meletakkan titik-titik yang berjajar rapi secara manual. Karena

itu, gambar atau foto yang kita lihat biasanya dihasilkan oleh mesin



10

seperti kamera, monitor, televisi, komputer, proyektor film, scanner,

printer dan sebagainya.

Resolusi

Jumlah pixel per centimeter disebut sebagai resolusi. Dan resolusi itulah

yang menentukan kualitas dari gambar yang dihasilkan. Gambar yang

sering kita lihat dalam komputer umumnya mempunyai resolusi 72 pixel

per inchi atau disingkat dpi. Sebagai contoh gambar yang berukuran satu

sentimeter persegi akan memiki 72 X 72 = 5184 titik atau pixel. Misal

gambar tersebut diperbesar dari 1 cm persegi menjadi 10 cm persegi

maka jumlah pixel keseluruhan adalah tetap yaitu 5184 pixel yang

berubah adalah resolusinya, yaitu 5184 : 100 = 5,184 pixel per cm.

Berarti jika suatu gambar diperbesar maka resolusinya akan semakin

kecil dan mengakibatkan gambar menjadi tidak tajam. Semakin tinggi

resolusi suatu gambar maka akan semakin tinggi kemampuan

perbesarannya.

Intensitas

Pixel pixel yang membentuk gambar tersebut memiliki warna warna

tertentu dan jumlah warna yang boleh dimiliki oleh suatu gambar

dinamakan intensitas. Biasanya dikenal istilah 256 warna, high color, 16

juta warna (true color) gradasi abu-abu (grayscale), serta hitam-putih

(black & white). Semakin banyak jumlah warna dalam suatu gambar

maka gambar yang dihasilkan akan semakin bagus. Jumlah warna

maksimum dari gambar dapat dilihat dari jenis filenya. Misal file gambar

yang berekstensi .jpg akan memiliki maksimum 16 juta warna, atau file

yang berekstensi .gif memiliki jumlah warna maksimum 256.

Pada Modul diklat ini akan dibahas tentang Photoshop 6.0 sebagai

software pengolah gambar Raster.  Sebelum menggunakan Photoshop
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6.0 pastikan anda memiliki beberapa konfigurasi minimum pada

komputer yang anda miliki yaitu:

(1) Sistem Operasi    : Windows 98

(2) Prosesor    : Pentium I

(3) Memori    :16 Mb

(4) Free Space hardisk  : 1 Giga

(5) Mouse

(6) VGA Card    : 256 Color

Konfigurasi diatas merupakan standar minimum dimana Photoshop 6.0

dapat dijalankan. Untuk menambah Performa kerja, sebaiknya

konfigurasi tersebut ditingkatkan.

3) Menjalankan Photoshop 6.0

• Nyalakan komputer

• Tunggu sampai jendela sistem windows tampil pada komputer anda.

• Klik kanan Start Menu yang berada pada bagian pojok kiri bawah

layar.

Gambar 1 Start Menu pada Windows 98

• Geser mouse anda ke sub menu Program, kemudian akan tampil grup

menu.

• Geser mouse anda ke grup Photoshop 6.0, sehingga tampil sub grup

Photoshop .
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• Klik Kanan mouse anda pada pilihan Photoshop 6.0, tunggu beberapa

saat, setelah proses berhasil maka ditampilkan Layar kerja Photshop

6.0 seperti Gambar 2.

Gambar 2. Tampilan Layar Kerja Photoshop 6.0

Gambar di atas adalah gambar tempat kita bekerja di dalam photoshop,

ruang kerja ini terdiri set standard tools, tool option, menus dan palletes.

Title Bar

Adalah Judul Program yang sedang aktif

Toolbox

Adalah tempat dimana tool-tool dari photoshop yang digunakan untuk

menggambar tersebut berada.

toolbox

tooloption

menu bar

palete

title bar
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Tool Option

Setiap tool mempunyai fungsi yang berbeda dan fungsi tersebut dapat

dimodifikasi melalui tool option. Setiap tool mempunyai tool option yang

berbeda-beda.

Pallete

Adalah tambahan dari setting untuk tool tool dan terdapat berbagai alat

bantu lainnya.

Menu Bar

Adalah baris yang berisi perintah yang dapat diaktifkan melalui klik

mouse dan shortcut keyboard.

4) Keluar dari Program Photoshop 6.0

Untuk keluar dari program aplikasi Photoshop 6.0 anda dapat

melaksanakan langkah-berikut ini:

• Klik File pada menu bar, akan tampil sub menu File.

• Klik Exit anda akan keluar dari program aplikasi Photoshop 6.0 dan

kembali pada sistem operasi windows 98.

• Anda juga dapat menggunakan short cut key Alt+Q

• Apabila anda belum melakukan proses penyimpanan terhadap

pekerjaan terakhir anda, maka  Photoshop 6.0 akan menampilkan

kotak dialog penyimpanan. Klik YES jika anda ingin menyimpan

pekerjaan anda, klik NO jika anda tidak ingin menyimpan pekerjaan

anda dan klik cancel bila ingin membatalkan keluar dari Photoshop

6.0.

• Apabila anda klik YES maka akan tampil kotak dialaog Save Drawing

yaitu kotak dialog yang menanyakan dimana lokasi direktori atau

folder tempat anda menyimpan pekerjaan anda.
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c. Rangkuman 1

Langkah-langkah membuka program aplikasi Photoshop 6.0 adalah:

1) Klik kanan start pada windows screen, pilih program, tampil sub

program,

2) pilih sub program Photoshop 6.0,

3) klik kanan program Photoshop 6.0,

4) tunggu sampai logo  Photoshop 6.0 muncul, kemudian akan muncul

layar kerja Photoshop 6.0.

Langkah-langkah menutup program aplikasi Photoshop 6.0 adalah:

1) klik kanan File pada menu bar,

2) klik kanan Exit,

3) atau tekan tombol alt+Q

4) akan muncul kotak dialog peringatan penyimpan, apabila anda

belum melaksanakan proses penyimpanan,

5) klik kanan Yes untuk menyimpan, No tidak menyimpan, dan Cancel

untuk membatalkan keluar.

Tugas 1

1) Buka aplikasi program Photoshop 6.0, lakukan pengamatan dengan

membuka beberapa pilihan menu yang ada pada program tersebut

2) Kliklah beberapa tombol yang berada di bawah pilihan menu.

Pilihan/perubahan apa yang tampil pada layar monitor ?

d. Tes Formatif 1

1) Apayang dimaksud resolusi  ?

2) Sebutkan langkah-langkah membuka program photoshop 6.0 !

3) Bagaimana cara anda keluar dari program Photoshop 6.0 dengan

menggunakan shortcut key ?
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e. Kunci Jawaban Formatif 1

1) Resolusi adalah Jumlah pixel per centimeter

2) Lihat kembali uraian materi 1

3) Dengan menekan tombol Alt+Q

f. Lembar Kerja 1

Alat dan bahan :

1 (Satu) unit komputer yang telah terinstal aplikasi Photoshop 6.0

Kesehatan dan Keselamatan Kerja

1) Berdo’alah sebelum memulai kegiatan belajar.

2) Bacalah dan pahami petunjuk praktikum pada setiap lembar

kegiatan belajar.

3) Pastikan komputer dalam keadaan baik, semua kabel penghubung

terkoneksi dengan baik.

4) Jangan meletakkan benda yang dapat mengeluarkan medan

elektromagnetik di dekat komputer (magnet, handphone, dan

sebagainya).

5) Gunakanlah komputer sesuai fungsinya dengan hati-hati.

6) Setelah selesai, matikan komputer dengan benar.

Langkah Kerja

1) Periksa semua kabel penghubung pada komputer.

2) Hidupkan komputer dengan menekan saklar pada komputer, jangan

menghidupkan komputer dengan memasukkan colokan ke stop

kontak ketika saklar dalam keadaan on.

3) Jika komputer telah hidup, panggil aplikasi Photoshop 6.0.

Tunggulah hingga proses loading selesai.
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4) Silahkan anda mengamati dan mencoba berbagai pilihan menu serta

tombol yang ada pada aplikasi tersebut. Pahami dan

hapalkanmasing-masing kegunaan menu dan tombol tersebut.

5) Jika telah selesai, tutuplah aplikasi Photoshop 6.0 anda dan

matikanlah komputer dengan benar.
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2. Kegiatan Belajar 2: Membuat Obyek Baru dengan Menggunakan

Tulisan Tangan (Free Hand)

a. Tujuan Kegiatan Pemelajaran

1) Objek gambar dan tools raster dikenali

2) Objek-objek baru dibuat dengan menggunakan tulisan tangan/ free-

hand.

3) Objek free-hand dihaluskan dengan menggunakan efek-efek

penghalus (smooting).

4) Objek free-hand diintegrasikan dengan objek-objek dasar gambar

lainnya.

b. Uraian Materi 2

1) Menu Photoshop

Sebelum membuat Obyek baru dengan menggunakan tulisan tangan

(free hand), berikut ini dijelaskan bagian-bagian dari Photoshop meliputi

menu, toolbox, pallete.

Gambar 3. Menu Bar pada Photoshop

Menu Bar pada Photoshop terdiri dari:

File

Menu File berisi pilihan-pilihan seperti, membuat gambar baru,

menampilkan gambar, menyimpan, mencetak, mengimpor gambar,

mengekspor gambar, dan keluar program. Menu file ini sudah umum dan
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hampir semua program mempunyai isi yang sama sehingga tidak perlu

dijelaskan lebih lanjut.

Edit

Terdiri dari pilihan-pilihan, seperti, copy, paste, dan tool tool untuk

modifikasi gambar. Tool dibagian edit sebagian besar sudah diwakili oleh

toolbox dan pallete

Image

Bagian bagian yang penting adalah:

Gambar 4. Pulldown Menu Image

• Mode

Untuk menetukan mode dari gambar. Mode ini sudah ditanyakan pada

saat membuat gambar baru, dan fasilitas ini kita gunakan untuk

mengubah mode gambar yang telah kita tentukan sebelumnya. Misal

pada saat membuat file baru kita tentukan mode dari gambar adalah
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grayscale sehingga gambar yang dibuat tidak bisa mempunyai warna lain

selain hitam dan putih. Kemudian ditengah perjalanan kita berubah

pikiran untuk mengisikan warna lain selain hitam dan putih maka mode

warna harus diubah ke mode warna yang lain, misal RGB.

• Adjust

Untuk memanipulasi pewarnaan pada gambar. Dalam adjust diberikan

fasilitas yang sangat banyak yang digunakan untuk mengubah pewarnaan

dari gambar. Untuk dapat memahaminya tidak bisa melalui pengertian

tetapi harus sering melakukan latihan. Bagian ini tidak dijelaskan tetapi

langsung diterapkan pada latihan latihan pada bab bab selanjutnya.

Diharapkan melalui latihan tersebut bisa lebih bisa memahami

kegunaannya masing masing.

• Duplicate

Digunakan untuk menduplikat gambar yang sudah dibuat. Jika kita

menggunakan fasilitas ini maka akan terbentuk dua gambar yang sama.

• Image size

Untuk mengubah ukuran gambar baik memperbesar maupun

memperkecil. Image size tidak bisa merubah bagian bagian tertentu saja

dari gambar tetapi mengubah secara keseluruhan.

       (a) Ukuran awal   (b) setelah diperkecil
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Gambar 5. Mengubah Ukuran Gambar dengan Image Size

• Canvas size

Untuk mengubah ukuran kertas. Pengubahan ukuran kertas tidak akan

berpengaruh pada ukuran gambar.

 (a) Gambar awal      (b)  setelah canvas diperbesar

Gambar 6. Mengubah Ukuran kertas dengan Canvas Size

• Rotate canvas

Digunakan untuk memutar gambar

ü 90ocw = clock wise artinya memutar gambar 90 derajat searah jarum

jam

ü 90o ccw = counter clock wise artinya memutar gambar 90 derajat

berlawanan arah jarum jam

ü arbitrary memutar gambar sesuai dengan nilai derajat yang

dimasukkan

ü flip horizontal mencerminkan gambar horisontal. Artinya bagian kiri

gambar pindah ke kanan dan sebaliknya

ü flip vertikal mencerminkan gambar vertikal. Gambar yang diatas akan

berada di bawah dan juga sebaliknya. Hal ini berbeda dengan

memutar 180o.
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   (a) gambar asli       (b) flip vertikal              (c) diputar 180o

Gambar 7.  Rotate Canvas

Layer

Berhubungan dengan lapisan-lapisan yang membangun suatu image.

Select

Berhubungan dengan seleksi untuk merancang image yang kemudaian

dapat dilakukan filterisasi dan memberikan effect pada image.

Filter

Berguna untuk memberikan efek pada gambar.

View

Bagian bagian yang penting:

• show/hide rulers untuk menampilkan alat bantu penggaris

• show >grid untuk menampilkan alat bantu grid

Snap berguna pada saat kita menggeser sebuah object. Jika fasilitas snap

digunakan maka pada saat menggeser object akan mudah menyesuaikan

atau menempel pada grid atau dengan object lain.
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Setting dari grid dan rullers, misalnya satuan yang digunakan, warna dari

grid, dapat diubah melalui menu edit>preferences>units and

rulers…/guides and grid…

Fasilitas fasilitas diatas dapat kita gunakan untuk membantu mengatur

posisi gambar agar letaknya lebih presisi. Karena hanya merupakan alat

bantu maka tidak akan muncul jika gambar dicetak.

      (a) rulers                (b) grid

Gambar 8. View Grid dan View ruler

Window

Digunakan untuk mengatur lingkungan kita bekerja membuat desain

seperti pilihan yang menampilkan atau menyembunyikan toolbox dan

pallete, serta pilihan untuk mengatur gambar di dalam workspace.

Help

Terdiri dari pilihan, online help, informasi plug-in dan versi photoshop.

Help digunakan untuk mencari solusi dari masalah yang dihadapi ketika



23

menggunakan photoshop serta mencari tahu kegunaan dari tool dan

pallete.

Help yang paling sering digunakan adalah content yaitu semua informasi

tentang tool tool yang ada dalam photoshop dan bagaimana

memakainya. Sebenarnya kita belajar sudah cukup melalui help ini tetapi

yang menjadi kendala adalah masalah bahasa karena bahasa yang

digunakan adalah bahasa Inggis.

2) Toolbox

Toolbox ini adalah bagian yang paling penting didalam kita bekerja untuk

membuat desain. Bagian ini terdiri dari banyak tool yang digunakan untuk

membuat gambar dan memanipulasi gambar.

Setiap tombol tool yang tampak didalam toolbox bisa mempunyai lebih

dari satu pilihan tool karena masih ada kemungkinan tool tersebut terbagi

lagi menjadi sub tool.

Misal tool paint brush memliki dua pilihan yaitu paint brush tool atau

pencil tool. Untuk mengetahui apakah tool tersebut hanya terdiri satu

macam atau lebih maka tekan tool tersebut sekitar satu detik. Jika tool

tersebut memiliki lebih dari satu macam, maka pilihan tersebut akan

muncul.
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Gambar 9. ToolBox menu

Setiap tool juga mempunyai tool option, yaitu pilihan untuk mengatur

setting dari tool itu sendiri. Tool option otomatis akan muncul jika kita

menekan salah satu tool. Letak dari tool option secara default berada

dibawah menu dan bisa diubah letaknya sesuai dengan yang diinginkan.

Misal ditekan tool paint brush maka akan muncul tool option seperti

berikut:

Gambar 10. Tool Option

Selection Tool

Drawing Tool

Path and Type Tool

Operation canvas Tool

Operation windows Tool

Tool Option
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Pada tool option tersebut ada beberapa pilihan yang digunakan untuk

mengatur konfigurasi dari paint brush. Fungsi dari masing-masing tool

option akan dijelaskan dibagian selanjutnya.

Tidak semua tool akan dijelaskan disini karena ada tool-tool tertentu yang

membutuhkan pemahaman yang agak lama dan kegunaanya untuk

tingkat lanjut.

3) Painting tools

Painting tool yaitu peralatan untuk menggambar dan mendesain. Ada

beberapa macam pilihan tool yaitu:

• paint brush, digunakan untuk membuat gambar dengan memakai

kuas

• pencil, digunakan untuk membuat gambar dengan memakai pensil.

• air brush, digunakan untuk membuat gambar dengan  menggunakan

cat semprot .

• eraser, digunakan untuk menghapus bagian yang salah.

• background eraser, digunakan untuk menghapus background agar

gambar menjadi transparan.

• paint bucket, digunakan untuk memberi warna pada gambar.

• Type, digunakan untuk membuat tulisan.

• custom shape, digunakan untuk membuat bentuk sesuai dengan

bentuk yang disediakan.

• sharpen, digunakan untuk menajamkan gambar.

• blur, digunakan untuk mengaburkan gambar.

• smudge, digunakan untuk mengaburkan gambar sehingga nampak

seperti dihapus dengan tangan.
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paint brush    pencil      air brush

eraser     background eraser     paint bucket

     blur          sharpen      smudge

Type       custom shape

Gambar 11. Painting Tools

Selain tool untuk menggambar disediakan juga tool untuk alat bantu.

hand     zoom

untuk menggerakkan                 untuk memperbesar dan
gambar        memperkecil gambar

Gambar 12. Alat Bantu Painting Tools
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Untuk tool paint brush, pencil, air brush, eraser, backgroud eraser, blur,

sharpen, smudge mempunyai tool option yang hampir sama, yaitu:

Gambar 13. Tool Option Paint Brush

Brush

Untuk menentukan bentuk alat dan besarnya alat gambar. Tekan tombol

panah bawah  kemudian akan muncul bentuk dan ukurannya. Pilih

ukuran dan bentuk sesuai dengan yang diinginkan.

Gambar 14. Bentuk dan ukuran Brush (kuas)

Jika pilihan brush masih kurang atau masih belum memenuhi yang kita

perlukan maka klik tanda panah  yang ada pada ujung kanan atas

sehingga muncul menu pilihan seperti dibawah ini.
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Gambar 15. Menampilkan ukuran brush yang lain

Di tempat tersebut disediakan pilihan yaitu assorted brushes, calligraphic

brushes, drop shadow brushes, faux finish brushes, natural brushes, dan

square brushes. Jika kita memilih salah satu dari option tersebut maka

akan muncul pertanyaan seperti berikut:

Gambar 16. Menu Konfirmasi penggantian Brush

Jika dipilih OK  pilihan brush yang sebelumnya digantikan dengan pilihan

yang baru. Jika dipilih append maka pilihan sebelumnya akan

digabungkan dengan pilihan yang baru sehingga jumlahnya banyak.

Ketika pilihan brush yang sudah dimasukkan terlalu banyak dan dapat

membingungkan maka bisa dikembalikan lagi ke keadaan semula dengan

mengklik tanda panah dan memilih menu reset brushes.
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Opacity digunakan untuk menentukan transparansi dari alat gambar.

Jika opacity digunakan 100 % maka hasilnya tidak akan transparan.

Semakin kecil opacity maka hasilnya akan semakin transparan.

Wet edges digunakan untuk memberikan tambahan seperti cat yang

basah. Contoh disamping adalah paint brush dengan opacity 50% yang

disapukan pada gambar.

Gambar 17. Pengaturan Opacity

a)  Menggambar dan Melukis dengan Tool

Untuk membuat obyek gambar dapat digunakan drawing Tool

Gambar 18. Drawing Tool

b)  Melukis dengan Airbrush Tool

Ikuti langkah berikut:

Drawing Tool



30

• Seleksi image dengan selection tool

• Klik airbrush tool, tetapkan warna foreground

• Pilih type brush dengan klik air brush

• Arahkan pointer pada layar kerja, warnailah image yang diseleksi.

c)  Mewarnai dengan Paint Bucket Tool

• Seleksi image dengan selection tool

• Klik Paint Bucket tool, tetapkan warna foreground

• Pilih option paint bucket  dengan klik paint bucket dan tahan sehingga

muncul pilihan gradient tool dan paint bucket tool.

• Pilih Paint Bucket

• Arahkan pointer pada image yang terseleksi, warnailah image yang

diseleksi, dengan klik mouse anda.

d)  Mewarnai dengan Gradient Tool

• Seleksi image dengan selection tool

• Klik Paint Bucket tool, tetapkan warna foreground

• Pilih option paint bucket  dengan klik paint bucket dan tahan sehingga

muncul pilihan gradient tool dan paint bucket tool.

• Arahkan ke gradient tool

• Arahkan pointer pada image yang terseleksi, warnailah image yang

diseleksi, dengan klik dan geser mouse anda pada arah yang anda

inginkan.

• Bila mouse digeser pada arah vertikal maka warna gradient  akan

mempunyai vertikal.
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Warna gradien tool dapat diubah melalui option bar yang tampil ketika

gradient tool dipilh.

Gambar 19. Mewarnai dengan Gradient Tool

Warna gradient tool dapat dimodifikasi dengan cara menampilkan kotak

dialog gradient editor. Untuk menampilkan Kotak dialog Gradient Editor

klik pada kotak edit warna. Sehinga tampil seperti gambar dibawah ini:

Arah Mouse

Option barKotak edit warna
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Gambar 20. Kotak Dialog Gradient Editor

Langkah selanjutnya adalah :

• Pilih warna dalam kotak preset

• klik kotak kecil dibawah gradient warna yang telah ada.

• Gantilah warna yang diinginkan pada kotak stop.

• Untuk menambah warna gradient klik pada bagian bawah warna

gradient, sehingga tampil color stop baru.

• Pilih warna yang diinginkan dengan klik color pada pilihan stop.

• Klik New apabila ingin menambah koleksi warna padda preset.

• Maka warna akan tampil pada preset.

• Klik Ok.

Kotak Preset



33

e)  Melukis dengan Pencil Tool

• Klik pencil tool.

• Tetapkan warna foreground.

• Pada option pencil tool, klik brush sehingga muncul pilihan untuk jenis

brush untuk menentukan ketebalan garis.

• Arahkan pointer pada layar kerja (canvas), buatlah gambar yang anda

inginkan.

• Bentuk yang dihasilkan sangat tergantung pada kepandaian kita

menggerakkan mouse, dan tentu saja keahlian menggambar.

Gambar 21. Menggambar dengan Pencil Tool

f)  Mewarnai dengan Paintbrush Tool

• Seleksi image dengan selection tool

• Klik Paintbrush tool, tetapkan warna foreground

• Pada option paintbrush klik brush sehingga muncul pilihan type brush.

Pilihan Brush
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• Klik type brush yang anda inginkan

• Arahkan pointer pada image yang terseleksi, warnailah image yang

diseleksi, dengan klik mouse anda pada arah yang anda inginkan.

Gambar 22. Mewarnai dengan Paintbrush Tool

g)  Membuat Garis dengan Pen Tool

• Klik Pen tool.

• Pada pen tool bar, klik dan tahan  sehingga muncul pilihan untuk tipe

Pen untuk menentukan jenis dari pen

ü FreeForm Pen untuk membuat kurva yang tidak beraturan

dengan mendrag pointer mouse.

ü Add Anchor Point Tool untuk menambah titik pada garis

ü Delete Anchor Point Tool untuk untuk mengurangi titik pada

garis

ü Convert Point Tool untuk membuat kelengkungan titik

• Arahkan pointer pada layar kerja (canvas), buatlah gambar yang anda

inginkan.
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• Klik pada satu posisi dikanvas kemudian klik pada posisi yang lain.

• Akan muncul gambar garis lurus.

Gambar 23. menggambar dengan Pen Tool

h)  Membuat Beberapa Obyek Menggunakan Shape Tools

Shape tools digunakan untuk menggambar garis, kotak, kotak dengan

sudut melingkar, dan elips pada suatu gambar pada Photoshop, dapat

juga menggambar polygons dan membuat bentuk-bentuk pilihan untuk

digunakan kembali.

Gambar 24. Shape Tool pada Option Bar
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Pilih salah satu bentuk pada options bar, dan klik tanda panah terbalik

untuk menampilkan beberapa pilihan dari bentuk yang telah dipilih.

i)  Membuat Kotak Dengan Shape Tool

• Klik rectangle tool

• Pilih warna foreground

• Drag mouse pada canvas

• maka akan tampil gambar kotak

• klik tanda cheklist sebelah kanan atas  untuk mengakhiri

• Dengan cara yang sama dapat dibuat bentuk-bentuk yang lain.

• Anda dapat juga memilih berapa bentuk yang lain dengan memilih

shape pada option bar.

Gambar 25. Menggambar Bentuk dengan Shape Tool

Check listoption bar
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4.  Seleksi

Seleksi adalah tool untuk menyeleksi suatu bidang dari gambar dan

membedakan dari bidang lainnya. Seleksi berperan penting dalam

memanipulasi gambar atau desain. Sebagian besar dari tool memerlukan

seleksi untuk membantu mengaplikasikannya. Tanda dari bidang yang

diseleksi adalah dibatasi oleh garis putus putus yang berkedip-kedip.

         area seleksi

Gambar 26. Area Seleksi

Tool berfungsi untuk seleksi adalah:

Marque tool , lasso tool , dan magic wand . Kegunaan dari

masing masing tool tersebut akan dibahas satu persatu.

a)  Marque tool

Marque tool adalah untuk membuat seleksi dengan bentuk seperti yang

disediakan. Untuk memilih bentuknya, tekan sekitar satu detik maka

pilihan bentuk akan muncul. Pilihan bentuk yang disediakan yaitu

persegi, elip, garis vertikal dan garis horisontal.
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Gambar 27. Marque tool

b)  Lasso tool

Lasso tool adalah untuk membuat seleksi dengan bentuk yang tidak

beraturan sesuai dengan yang kita inginkan. Pilihan dari lasso tool ada

tiga macam yaitu: lasso tool, polygonal lasso tool, magnetik lasso tool.

• Lasso tool

Cara memakainya adalah klik dimana lintasan dari seleksi akan dimulai.

Dengan keadaan masih mengklik gerakkan mouse dengan lintasan

sesuai dengan yang diinginkan. Setelah selesai lepaskan mouse maka

akan terbentuk seleksi tertutup mengilkuti lintasan yang telah dibuat.

Lasso tool   magnetik lasso tool

Gambar 27. Seleksi dengan Lasso dan Magnetik Lasso Tool

Pilihan dari marque tool
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• Magnetik lasso tool

Ketika menyeleksi suatu obyek dengan menggunakan lasso tool

terkadang mengalami kesulitan untuk menggerakkan agar tepat berada

di sisi terluar gambar. Untuk mengatasi hal tersebut maka dapat kita

gunakan magnetik lasso tool. Jika kita gerakkan magnetik lasso secara

otomatis akan mengikuti sisi terluar gambar walaupun gerakan kita

tidak persis di sisi gambar. Cara melakukannya klik di awal lintasan dari

seleksi lalu lepaskan dan sisir lintasan gambar yang dikehendaki.

Setelah kedua ujung bertemu lalu doube klik maka akan terbentuk

seleksi.

• Polygonal lasso tool

Polygonal lasso tool berfungsi untuk menyeleksi dengan bentuk

polygon atau banyak sisi. Cara membuatnya klik titik sudut dari poligon

seleksi yang dikehendaki.

Gambar 28. Seleksi dengan Polygonal Lasso Tool
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• Magic wand

Magic wand adalah salah satu kemudahan yang ditawarkan oleh

photoshop didalam membuat seleksi. Prinsipnya adalah tool ini akan

menyeleksi daerah yang warnanya sama atau hampir sama. Daerah

yang diseleksi akan meliputi tempat yang diklik dan daerah disekitarnya

yang memiliki warna hampir sama.

Caranya klik daerah yang dikehendaki maka seleksi akan terbentuk.

Sebagai catatan bahwa magic wand akan mencari warna yang hampir

sama dengan warna pada daerah yang diklik. Jika grafiknya sangat

komplek dan menggunakan banyak warna yang berbeda, misalnya foto,

maka magic wand tidak akan berfungsi dengan optimal.

Gambar 29. Seleksi dengan Magic Wand

Di bagian tool option dari magic wand terdapat option tolerance

.

Option tersebut digunakan untuk mengatur toleransi warna yang

diperbolehkan untuk ikut dalam seleksi.  Jika dipilih nilai toleransi yang

sangat tinggi maka walaupun perbedaan warna agak jauh, daerah

tersebut masih tetap masuk dalam seleksi.

Seperti contoh digambar 30, karena setting tolerance diisi 100 maka

ketika yang diklik adalah lingkaran didalam, lingkaran yang kedua akan
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ikut dalam seleksi walaupun perbedaan warnanya agak jauh.  Setting

tolerance=100.

Gambar 30. Pengaturan Option Tolerance

Posisi dari seleksi yang sudah dibuat dapat dipindah ke tempat lain.

Caranya klik bidang didalam seleksi lalu pindahkan ke tempat yang

diinginkan.

Dari ketiga tool diatas terdapat  tool option yang hampir sama yaitu

tentang pengaturan bidang seleksi.

Seleksi baru        Menambah seleksi   Mengurangi seleksi    Irisan dua seleksi

Gambar 31. Tool Option pada Magic Wand

• Seleksi baru

Jika kita memilih option seleksi baru maka setelah dibuat seleksi dan

dibuat seleksi ditempat lain maka seleksi yang pertama akan hilang. Hal
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ini disebabkan karena option seleksi baru tidak memperbolehkan lebih

dari satu seleksi.

seleksi pertama dibuat

Gambar 32. Contoh New Selection

• Menambah seleksi

Jika kita pilih option ini maka akan diperbolehkan lebih dari satu seleksi.

• Mengurangi seleksi

Mengurangi seleksi adalah digunakan untuk memotong seleksi yang

sudah terbentuk. Jadi seleksi ini tidak membuat seleksi baru tapi

mengurangi seleksi yang sudah ada. Jika kita memilih option ini

pastikan bahwa sebelumnya sudah terdapat seleksi pada gambar, jika

tidak maka seleksi ini tidak berfungsi.

seleksi kedua dibuat, maka
seleksi yang pertama akan
hilang
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seleksi yang akan dikurangi                         proses pengurangan dengan elips

             hasil pengurangan

Gambar 33. Proses Pengurangan pada Seleksi

• Irisan dua seleksi

Irisan digunakan untuk membuat irisan dari dua buah seleksi. Seleksi

yang berada diluar dari irisan akan hilang.

Gambar 34. Irisan dengan Dua Buah Seleksi

seleksi pertama proses isan dengan
elips

hasil
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5)  Manipulasi dengan Seleksi

Pada bagian sebelumnya telah kita pelajari segala macam yang

berhubungan dengan pembuatan seleksi. Pada bagian ini akan

membahas tentang apa yang dapat dilakukan dengan seleksi.

§ Mengubah seleksi yang sudah dibuat

Hal hal yang berhubungan dengan seleksi diatur dalam menu select.

Sekarang akan kita bahas satu persatu kegunaanya.

Gambar 35. Menu Bar Select

ü All: digunakan untuk menyeleksi seluruh area dari gambar

ü Deselect: digunakan untuk menghilangkan seleksi yang sudah

dibuat sebelumnya

ü Reselect: kembali memunculkan seleksi yang sebelumnya telah

dihilangkan.

ü Inverse: untuk membalikkan daerah yang diseleksi. Misal daerah

yang diseleksi adalah setengah area gambar bagian bawah. Jika kita

perintahkan operasi inverse maka seleksi akan berpindah pada
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daerah yang sebelumnya tidak terseleksi yaitu setengah area

gambar bagian atas.

               seleksi             setelah dilakukan operasi inverse

Gambar 36. Inverse Selection

ü color range: digunakan untuk menyeleksi warna yang kita

inginkan.

ü feather: digunakan untuk mengaburkan batas antara daerah yang

diseleksi dengan daerah luarnya. Jika kita memberikan warna pada

seleksi yang telah diberikan feather maka batas dari gambarnya

akan kabur.

                tanpa feather                 dengan feather

Gambar 37. Seleksi dengan Feather
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ü modify: digunakan untuk mengubah seleksi yang sudah dibuat.

Terdapat empat pilihan yaitu border, smooth, expand, contract.

ü border: digunakan untuk membuat seleksi baru dengan ketebalan

tertentu yang mengikuti lintasan dari seleksi sebelumnya.

            seleksi                                   diberi border

Gambar 38. Seleksi dengan Border

ü smooth: digunakan untuk memperhalus lintasan dari seleksi yang

sudah dibuat

ü expand: digunakan untuk memperbesar ukuran seleksi

         seleksi                 diberi expand sebesar 4px

Gambar 39. Seleksi dengan Expand
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ü contract: digunakan untuk memperkecil ukuran seleksi

  Seleksi       diberi contract sebesar 4 px

Gambar 40. Seleksi dengan Contract

ü grow: digunakan untuk memperbesar area dari seleksi hingga

seleksi memenuhi daerah yang memiliki warna yang sama. Fungsi ini

hampir sama dengan magic wand tool.

ü Transform: selection digunakan untuk mengubah seleksi sesuai

dengan keperluan.

ü Save selection: digunakan untuk menyimpan seleksi yang sudah

kita buat sehingga bisa kita gunakan lagi pada lain waktu. Fasilitas

ini umumnya digunakan untuk menyimpan seleksi yang cukup rumit

dan membutuhkan waktu untuk membuatnya.

c. Rangkuman 2

Pembuatan obyek dengan freehand berhubungan dengan Drawing

Toolbox. Drawing ToolBox berisi tool seperti Pen Tool, Pencil Tool, Erase

Tool, Paint Tool, Airbrush Tool, Paint Bucket Tool dll. Untuk menggambar

suatu Obyek Tool tersebut dapat dikombinasikan satu dengan yang

lainnya.
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Selain Obyek yang dapat kita buat sendiri Photoshop juga menyediakan

obyek-obyek yang sudah tersedia dalam berbagai bentuk (shape). Kita

tinggal menggunakan bentuk tersebut untuk digunakan dalam proses

menggambar.

Penggabungan berbagai bentuk dapat menggunakan teknik seleksi.

Teknik ini mengijinkan kita mewarnai suatu obyek yang telah diseleksi,

menggabungkan, mengurangi, dan mencari irisan dari dua buah obyek.

d. Tugas 2

1) Buat file baru dengan ukuran 250X250px

2) Klik Gradien Tool, buatlah gradient yang menutupi seluruh area

gambar dengan arah vertikal. Pilih warna gradient sesuai dengan

selera. Jumlah warna gradient sebaiknya lebih dari dua kombinasi.

Seperti contoh disamping menggunakan 5 kombinasi warna

Gambar 41. Gradien Menggunakan 5 Kombinasi Warna

3) Buat seleksi berbentuk persegi seperti contoh disamping. Kemudian

pilih menu select>feather dan isikan setting 8px
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Gambar 42. Seleksi Rectangle >Select Feather

4) Dengan seleksi yang masih tetap ada pilih menu

filter>distort>zigzag dengan setting:  style:pound ripples dan

setting amount dan ridges dapat dipilih sendiri sesuai dengan selera.

Maka hasil akan seperti gambar 43

5) Simpan dengan nama tugas2 !

Gambar 43. Hasil Gambar
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e. Tes Formatif 2

Buatlah gambar kerucut seperti dibawah ini

Gambar 44. Gambar Kerucut

f. Kunci Jawaban Formatif 2

1) Buat file baru dengan ukuran 300X300 px dan buat seleksi

berbentuk persegi

2) Buat layer yang baru

3) Gunakan gradient tool dan pilih warna gradasi copper

4) Buat gradasi horisontal ke dalam seleksi yang sudah dibuat.
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5) Dengan seleksi yang masih ada pilih menu edit>free transform

sehingga muncul kotak kecil di tiap tiap titik sudutnya

6) Klik kanan gambar tersebut dan pilih menu persperctive

7) Geser kotak kecil yang berada di sudut kanan atas menuju ke kiri

dan bertemu dengan kotak kecil yang berada di kiri atas sehingga

membentuk sebuah kerucut.

8) Setelah selesai tekan keyboard enter

9) Buat seleksi berbentuk elips seperti contoh gambar disamping
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10) Buat seleksi kedua yang berbentuk persegi, pastikan pada tool

option dari seleksi pada kondisi menambah . Seleksi

dibuat dari atas gambar hingga berpotongan dengan seleksi yang

berbentuk ellips seperti contoh gambar disamping

11) Pilih menu select>inverse untuk membalikkan daerah yang

diseleksi. Kemudian tekan keyboard delete

12) Tambahkan bayang bayang dengan memilih menu layer>layer

style>drop shadow dan buat setting yang sesuai
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g. Lembar Kerja 2

Alat dan bahan :

Satu unit komputer yang telah terinstal aplikasi Photoshop 6.0

Kesehatan dan Keselamatan Kerja

1) Berdo’alah sebelum memulai kegiatan belajar.

2) Bacalah dan pahami petunjuk praktikum pada setiap lembar

kegiatan belajar.

3) Pastikan komputer dalam keadaan baik, semua kabel penghubung

terkoneksi dengan baik.

4) Jangan meletakkan benda yang dapat mengeluarkan medan

elektromagnetik di dekat komputer (magnet, handphone, dan

sebagainya).

5) Gunakanlah komputer sesuai fungsinya dengan hati-hati.

6) Setelah selesai, matikan komputer dengan benar.

Langkah Kerja

1) Periksa semua kabel penghubung pada komputer.

2) Hidupkan komputer dengan menekan saklar pada komputer, jangan

menghidupkan komputer dengan memasukkan colokan ke stop

kontak ketika saklar dalam keadaan on.

3) Jika komputer telah hidup, panggil aplikasi Photoshop 6.0.

Tunggulah hingga proses loading selesai.

4) Pilih menu file>new, ukuran kertas terserah dan background white.

5) Buat seleksi ellips dengan menggunakan tool seleksi dan tool

optionnya pilih new selection
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6) Buat warna gradient hitam ke putih dari atas ke bawah dengan

menggunakan tool gradient. Tool option pilih linear

, klik di bagian atas seleksi dan geser hingga ke

bawah seleksi.

7) Buat seleksi ellips yang kedua yang ukurannya lebih kecil dari ellips

yang pertama dan letaknya didalamnya. Tool optionnya pilih new

selecion  sehingga pada saat membuat seleksi kedua,

seleksi yang pertama akan hilang.
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8) Tekan delete untuk menghilangkan obyek yang berada di dalam

seleksi

9) Buat seleksi ellips yang ketiga yang ukurannya lebih kecil dari yang

kedua dan letaknya didalamnya. Untuk kali ini pada saat membuat

seleksi yang ketiga, seleksi yang kedua jangan sampai hilang.

Caranya dengan memilih tool option mengurangi seleksi

.

10) Buat warna gradasi yang kedua didalam seleksi tersebut yang

arahnya kebalikan dari gradasi yang pertama yaitu dari bawah ke

atas.
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11) Hilangkan semua seleksi yang ada dengan  memilih menu

select>deselect.

12) Hasil akhir adalah gambar seperti dibawah ini

13) Dengan cara yang sama buatlah gambar seperti dibawah ini:
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3. Kegiatan Belajar 3:  Menerapkan Efek Visual pada Obyek

Gambar

a. Tujuan Kegiatan Pemelajaran

1) Memahami dan mengaplikasikan Efek-efek visual lanjut, seperti:

penghalusan, perbesaran, pemecahan, pengaburan.

2) Dapat memanipulasi Objek gambar lain seperti foto, dengan

menggunakan efek-efek visual.

b. Uraian Materi 3

1)  Konsep layer

Layer digunakan untuk menggabungkan beberapa gambar menjadi satu

gambar. Setiap gambar diletakkan dalam satu lapisan layer dan

digabungkan dengan lapisan lapisan layer yang lain sehingga membentuk

gambar. Lapisan tersebut saling bertumpuk sehingga menghasilkan

sebuah gambar. Gambar yang berada pada layer atas maka akan berada

pada tumpukan yang paling atas dan bisa menutupi tumpukan gambar

yang berada dibawahnya.

Pada saat membuat gambar baru maka secara default akan mempunyai

sebuah  layer yaitu layer background. Layer tersebut adalah layer dasar

didalam membuat desain. Jika kita membuat beberapa layer baru maka

layer background akan tetap berada pada lapisan yang terbawah.

Sebaiknya dalam membuat desain, setiap obyek berada pada  layer yang

berbeda. Sehingga jika kita memanipulasi salah satu obyek maka

perubahannya tidak akan mempengaruhi obyek yang lain.

2)  Penggunaan pallete layer

Dalam photoshop segala hal yang berhubungan dengan layer diatur

dalam pallete layer. Pada gambar  dapat kita lihat, gambar zebra berada



58

pada layer diatas layer gambar singa. Oleh karena itu gambar zebra

dapat menutupi gambar singa karena zebra berada pada tumpukan yang

paling atas. Sedangkan background dapat ditutupi oleh gambar singa dan

zebra karena layer background berada paling bawah.

Gambar 45 Pallete Layer

Gambar 46. Konsep Layer Transprana

Gambar singa masih tampak walaupun ditutup oleh gambar zebra. Hal ini

karena layer zebra adalah transparan sehingga hanya gambar zebra yang

menutupi gambar singa. Jika kita membuat layer baru maka layer

tersebut adalah transparan.
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Sekarang kita akan membahas fungsi dari masing masing bagian dalam

pallete layer.

Gambar 47. Bagian Palette Layer

3)  Layer visibility

Layer visibility digunakan untuk memunculkan atau menyembunyikan tiap

tiap layer. Misal layer visibility dari miki dihilangkan dengan cara

mengkliknya, maka gambar dari miki tersebut tidak akan tampak dalam

gambar.Dengan menampilkan salah satu layer maka layer yang lain

dihilangkan untuk sementara. Dengan cara seperti ini maka kita bebas

mengedit layer tanpa terganggu dengan layer yang lain.

4)  Active layer

Active layer berguna untuk menentukan di layer mana kita akan bekerja.

Jika ingin bekerja di layer lain maka kita cukup memindah active layer ke

layer yang kita inginkan. Didalam keseluruhan layer kita tidak bisa

memberikan lebih dari satu active layer.

option

Mode

Layer Visibility

Active Layer

Delete Layer

New layer
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Active layer adalah bagian yang penting, dan kita harus selalu

memastikan dilayer  mana kita bekerja sebelum memanipulasi layer.

5)  Lock

Lock berfungsi untuk mengunci layer agar tidak dapat kita edit. Lock ada

4 macam yaitu:

lock transparant pixel : untuk mengunci layer yang transparan.

Misalkan jika kita memberikan coretan pada gambar, maka yang tercoret

hanya gambarnya saja sedangkan yang bagian transparan tidak berubah

lock image pixel: untuk mengunci layer agar tidak bisa

dimanipulasi. Tetapi letak gambar masih bisa diubah.

lock position: kebalikan dari lock image pixel, gambar bisa

dimanipulasi tetapi posisi tidak bisa dirubah.

lock all: untuk mengunci layer agar tidak bisa dilakukan apapun

terhadapnya

untuk melakukan lock maka pastikan terlebih dahulu layer mana yang

akan dikunci, letakkan active layer di tempat tersebut, kemudian layer

dikunci.

6)  Opacity

Opacity digunakan untuk menetukan tingkat transparansi suatu layer

terhadap layer yang lain. Seperti contoh gambar diatas memiliki opacity

100 yang artinya gambar sama sekali tidak transparan. Jika opacity diberi

nilai kurang dari 100 maka layer akan tampak transparan dan semakin

kecil nilainya maka layer akan semakin transparan. Jika suatu layer dibuat

transparan maka gambar yang berada pada layer dibawahnya akan dapat

menembus gambar pada layer transparan tersebut.
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7)  Mode

Didalam menu mode  disediakan berbagai model layer dan pengaruhnya

terhadap layer yang lain. Untuk mengetahui fungsi dan hasilnya terhadap

layer maka sebaiknya dicoba satu persatu dan dilihat perubahan pada

layernya. Pada saat membuat layer baru secara default mode layer diset

sebagai normal dan selanjutnya dapat diganti ke mode yang lain.

new layer digunakan untuk membuat layer baru.

delete layer digunakan untuk menghapus layer yang sudah dibuat.

Caranya letakkan tanda active layer pada layer yang akan dihapus. Baru

kemudian menekan tombol delete layer.

Jika kita tekan panah kecil yang berada di ujung kanan atas maka akan

muncul option. Diantara option tersebut yang paling penting adalah

bagian merge.

Merge berfungsi untuk menggabungkan beberapa layer menjadi satu

layer. Merge down artinya menggabungkan layer yang sedang aktif

dengan layer dibawahnya. Merge visible menggabungkan semua layer

yang visibility-nya diset aktif. Sedangkan layer yang visibility-nya tidak

diset aktif masih tetap berdiri sendiri.

8) Penggunaan Layer Style

Layer style adalah tambahan efek yang akan diberikan terhadap suatu

layer. Effect effect tersebut telah disediakan kita tinggal memilih dan

menerapkannya pada layer tersebut. Kita akan sering menggunakan efek

ini karena cara penggunaanya yang mudah dan hasilnya yang bagus.

Sebenarnya kita bisa membuat sendiri efek yang dihasilkan oleh layer

style dengan menggunakan drawing tool tetapi akan membutuhkan waktu

yang sangat lama. Oleh karena itu kita menggunakan efek ini dengan
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tujuan penghematan waktu. Effect tersebut hanya bisa diberikan pada

layer baru dan tidak bisa diberikan kepada layer background.

9) Penggunaan layer style

Macam macam layer style dapat dilihat pada menu layer>layer style

dan akan muncul pilihan pilihan. Untuk bisa melihat semua pilihan

tersebut maka pilih menu blending option sehingga muncul kotak dialog

seperti berikut:

Gambar 48. Layer Style
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• drop shadow: untuk memberikan bayangan dibawah obyek

Gambar 49. Efek Drop Shadow

• inner shadow: untuk memberikan bayangan didalam obyek

Gambar 50. Efek Inner Shadow

• outer glow: untuk memberikan sinar dibawah obyek

Gambar 51. Efek Outer Shadow

• inner glow: untuk memberikan sinar didalam obyek

Gambar 51. Efek Inner Glow

• bevel and emboss: untuk memberikan effect timbul dari obyek

• satin untuk memberikan effect bayangan yang menyeluruh dalam

obyek
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• color overlay: untuk menimpa obyek dengan warna lain

• gradient overlay: untuk menimpa obyek dengan warna gradient

• pattern overlay untuk menimpa obyek dengan warna pattern

• stroke: untuk memberikan warna di tepi obyek

10) Menggabungkan Layer-layer Menjadi Satu Image

• Klik segitiga yang terdapat dalam layer Pallete

• Pilih Flatten Image

• Maka semua layer menjadi satu layer Background

Gambar 52. Layer Sebelum Digabung ada Dua Layer

Gambar 53. Layer Sesudah Digabung ada Satu image
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11) Menggabungkan Beberapa Layer Menjadi Satu Layer

• Kelompokkan layer dengan klik icon Create new set, kemudian tampil

set 1.

• Drag Layer-layer yang ingin dikelompokkan

• klik set yang ingin digabungkan

• klik  segitiga pada layer pallete

• Pilih Merge layer Set

• Maka Hasilnya seperti berikut

Gambar 54. Membuat set baru dari layer
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Gambar 55. Hasil Penggabungan Layer Menjadi Satu Layer

12) Effect pada Layer

  a) Drop Shadow

Drop Shadow adalah fasilitas untuk membuat bayangan layer, berikut ini

caranya:

• Buatlah Layer baru

• Buatlah Obyek gambar pada layer tersebut

• klik  menu layer

• Pilih Style kemudian pilih Drop Shadow, Kemudian akan tampil Kotak

dialog Layer Style.

• Aturlah komponen pembuatan shadow

• Maka akan tampil gambar dengan shadow (bayangan)
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  b) Inner Shadow

• Buatlah Layer baru

• Buatlah Obyek gambar pada layer tersebut

• klik  menu layer

• Pilih Style kemudian pilih Drop Shadow, Kemudian akan tampil Kotak

dialog Layer Style.

• Aturlah komponen pembuatan shadow

• maka akan tampil gambar dengan shadow (bayangan)

Dengan cara yang sama dapat dibuat efek-efek yang lain pada layer.

13) Penggunaan Filter

Filter merupakan tambahan fasilitas yang diberikan oleh photoshop.

Dengan adanya filter maka untuk memberikan efek pada suatu desain

menjadi lebih mudah.

Dibagian ini tidak semua filter akan dibahas, tetapi akan diajarkan

secara garis besarnya serta cara pemakaian. Filter yang ada dalam

photoshop jumlahnya mencapai ratusan buah, dan itu masih bisa

ditambah lagi dengan plug-ins dari luar dengan cara mendownload atau

membeli. Karena tidak dijelaskan satu persatu maka penulis

menyarankan agar filter dicoba satu persatu dan dilihat pengaruhnya

terhadap gambar. Dari cara tersebut maka akan lebih mudah memahami

fungsinya. Filter ini akan dipakai dalam contoh contoh pada bab

selanjutnya sehingga dapat dipelajari penggunaanya melalui praktek

langsung.

Filter dapat kita lihat dibagian menu filter. Dibawah ini contoh filter yang

diberikan secara default oleh photoshop.
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Gambar 56. Menu Bar Filter

Dibagian ini filter secara garis besar dibagi menjadi 13 jenis. Dan akan

dibahas satu persatu fungsinya. Jika ingin mengaplikasikan salah satu

filter tersebut maka sebaiknya kita tentukan terlebih dahulu bagian

mana dari gambar yang akan kita beri effect, lalu bagian tersebut

diseleksi.

Setiap filter mempunyai option untuk mengatur hasilnya sesuai agar

sesuai dengan keinginan kita. Jadi pada saat kita memilih salah satu

filter maka akan muncul kotak dialog yang akan meminta setting seperti

apa yang kita inginkan.

  a)  Artistic

Artistic memberi effect untuk merubah gambar menjadi seperti lukisan.

Didalam filter artistic disediakan berbagai pilihan. Sebagai contoh kita

gunakan filter colored pencil, filter ini berfungsi untuk mengubah

gambar menjadi seperti gambar yang dibuat dari arsiran pensil warna.
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           gambar awal               setelah diberi filter colored pencil

Gambar 57. Artistik Filter

  b)  Blur

Blur sesuai dengan artinya digunakan untuk mengaburkan gambar.

Filter ini adalah salah satu filter yang paling sering digunakan didalam

membuat desain. Didalam filter blur disediakan 4 pilihan utama yaitu

gaussian, motion, radial dan smart.

Gaussian: digunakan untuk mengaburkan gambar tanpa ada gerakan.

Motion blur: untuk mengaburkan gambar dengan gerakan

menyamping dan arahnya bisa ditentukan.

Radial: digunakan untuk mengaburkan dengan gerakan memutar.

Smart:hampir sama dengan gaussian tetapi dengan option yang lebih

banyak sehingga kita bisa lebih leluasa mengaturnya.
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     Radial blur                    Motion blur dengan sudut 450

Gambar  58. Filter Blur

  c)  Brush stroke

Fungsi dari filter brush stroke hampir sama dengan filter artistic yaitu

memberikan efek pada gambar menjadi seperti lukisan dengan berbagai

pilihan alat untuk melukis.

  d)  Distort

Filter ini berfungsi untuk mengacak gambar dengan suatu keteraturan

tertentu. Misalkan gambar dibuat bergelombang atau membentuk

seperti zig-zag

  e)  Noise

Filter noise digunakan untuk memberikan gangguan pada gambar,

misalkan diberikan gangguan bintik bintik disekitar gambar.
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  f)  Pixelate

Filter pixelate digunakan untuk memanipulasi pixel dari suatu gambar.

Seperti telah dijelaskan sebelumnya bahwa gambar terdiri dari titik titik

kecil atau pixel.

Gambar 59. Filter Pixelate>Mozaic

Seperti contoh diatas digunakan filter mosaic yang fungsinya yaitu

membuat gambar seperti memiliki resolusi yang kecil padahal pada saat

sebelum diberi filter dan sesudah tidak ada perbedaan resolusi.

Sehingga hasilnya adalah gambar akan tampak kabur karena dan

nampak pixel-pixelnya membesar.

  g)  Render

Filter render digunakan untuk memberikan efek tiga dimensi terhadap

suatu gambar.

Seperti contoh disamping diberikan filter 3D transform sehingga gambar

tampak seperti ditempelkan pada permukaan bola.



72

Gambar 60. Filter Render>3D Transform

  h)  Sharpen

Filter sharpen digunakan untuk membantu mempertajam suatu gambar.

  i)  Sketch

Filter ini berguna untuk memanipulasi permukaan dari suatu gambar.

seperti contoh dibawah, gambar dibuat seperti rilief dalam permukaan

batu.

Gambar 61. Menggunakan Filter Bas Relief
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  j)  Stylize

Filter ini memberikan effect tiga dimensi serta mengubah tekstur dari

gambar

  k)  Texture

Filter ini fungsinya hampir sama dengan filter sketch yaitu memanipulasi

permukaan dari suatu gambar.

14) Memanipulasi Gambar

Seleksi juga mampu memanipulasi gambar yang sudah ada sehingga

menjadi sesuai dengan yang kita inginkan. berikut ini beberapa hal yang

bisa dilakukan oleh seleksi.

  a)  Menduplikat gambar

Gambar yang telah diseleksi bisa dikopi dan ditempel sebanyak yang kita

suka atau ditempelkan ke gambar yang lain. Caranya bagian gambar

yang telah diseleksi dikopi dengan memilih menu edit > copy.

Kemudian tempel di gambar tersebut atau di gambar lain dengan

memilih menu edit>paste.

                 dikopi bagian kepala   dipaste ke tempat lain

Gambar 62. Duplikasi Gambar dengan Copy-Paste
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  b)  Memotong Gambar

Seleksi juga bisa kita gunakan untuk memotong. Jadi hanya bagian yang

diseleksi yang akan hilang. Caranya dengan menekan keyboard delete

atau memilih menu edit>cut.

  c)  Mengkopi Gambar ke Dalam Gambar yang Lain

Untuk mengkopi gambar yang diseleksi ke gambar lain bisa dilakukan

dengan cara didrag  lalu dimasukkan ke dalam gambar lain.

Langkah-langkahnya adalah :

• Buat seleksi untuk gambar yang akan dikopi(gambar a.),

• Buka file gambar yang akan ditempel oleh gambar yang telah

diseleksi tersebut.

• Letakkan kedua gambar berdampingan agar pada saat mendragnya

lebih mudah.

• Drag gambar yang diseleksi dengan menggunakan move tool

menuju gambar yang kedua. Atur posisinya agar sesuai.

             a                  b

Gambar 63. Proses Seleksi Terhadap Gambar a Untuk Dikopi di b
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Gambar 64. Drag Gambar a ke arah gambar b

  d)  Mengubah Gambar Dengan Seleksi

Gambar yang telah diseleksi dapat diubah ubah sesuai dengan keinginan

kita, perubahan itu dapat berupa ukuran, warna, dll. Untuk memutar,

memperbesar, atau memperkecil, setelah gambar diseleksi pilih menu

edit>free transform. Kemudian gambar yang diseleksi tersebut akan

dibatasi oleh persegi empat. Setelah selesai memanipulasi bentuknya

maka tekan keyboard enter atau jika membatalkan perubahan yang

sudah dibuat dan ingin dikembalikan ke keadaan semula maka tekan

keyboard escape. Pada saat kita menggunakan fasilitas ini maka kita

tidak bisa mengoperasikan yang lainnya sebelum kita menekan tombol

escape atau enter.
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     gambar diseleksi     gambar diputar & diperkecil                 hasil

Gambar 62. Mengubah Gambar dengan Proses Seleksi

c. Rangkuman 3

Efek-efek visual dapat menerapkan konsep layer, seleksi dan filter,

dengan ketiga konsep tersebut kita sudah dapat melaksanakan efek-

efek visual seperti penghalusan, pembesaran, pemecahan gambar dan

pengaburan. Dengan demikian manipulasi obyek dalam bentuk gambar

ataupun foto dapat dilaksanakan pula.

d. Tugas 3

1) Buatlah file baru dengan ukuran 400X100 pixel dengan background

berwarna hitam.

2) Buatlah  sebuah text didalamnya dan rasterize layer tersebut

3) Duplikat layer dari teks tersebut.
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4) Letakkan aktif layer pada layer glowing yang pertama kali dibuat.

5) ekan tombol control, tahan dan klik layer glowing untuk menyeleksi

teks yang sudah dibuat.

6) Pilih menu select>expand untuk memperbesar ukuran seleksi

7) Gunakan paint bucket tool untuk menambahkan warna putih pada

seleksi. Klik berulang ulang hingga seluruh seleksi dipenuhi warna

putih

8) Hilangkan seleksi, dan masih tetap pada layer teks yang pertama,

pilih menu filter>blur>gaussian blur dan isikan setting 10px

9) Pindahkan aktif  layer pada layer teks yang kedua yaitu layer

glowing copy.

10) Berikan style pada teks, sesuai dengan keinginan. Pada contoh

disamping menggunakan style color target(button)
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Gambar 63. Pembuatan Teks Bercahaya
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e. Tes Formatif 3

Buatlah gambar beruang digambar A menjadi gambar beruang seperti

digambar B. Gambar A dapat anda ambil pada folder sample Adobe

Photoshop. Gunakan teknik seleksi dan pewarnaan obyek.

Gambar A             Gambar B
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f. Kunci Jawaban Formatif 3

1) Bukalah file bear (beruang) pada folder sample fotoshop

2) Buat seleksi terhadap kepal beruang.

3) Klik Edit>Free Transform

4) Putar handle free transform kekiri sehingga kepala beruang

nengok kekiri.
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5) Buat seleksi terhadap background yang terlihat (background

Transparan).

6)  Beri pewarnaan terhadap seleksi sesuai warna kulit beruang.

7) Gunakan eyedrop untuk mengambil warna yang sama.
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g. Lembar Kerja 3

Alat dan bahan :

(Satu) unit komputer yang telah terinstal aplikasi Adobe Photoshop 6.0

Kesehatan dan Keselamatan Kerja

1) Berdo’alah sebelum memulai kegiatan belajar.

2) Bacalah dan pahami petunjuk praktikum pada setiap lembar

kegiatan belajar.

3) Pastikan komputer dalam keadaan baik, semua kabel penghubung

terkoneksi dengan baik.

4) Jangan meletakkan benda yang dapat mengeluarkan medan

elektromagnetik di dekat komputer (magnet, handphone, dan

sebagainya).

5) Gunakanlah komputer sesuai fungsinya dengan hati-hati.

6) Setelah selesai, matikan komputer dengan benar.

Langkah Kerja

1) Periksa semua kabel penghubung pada komputer.

2) Hidupkan komputer dengan menekan saklar pada komputer,

jangan menghidupkan komputer dengan memasukkan colokan ke

stop kontak ketika saklar dalam keadaan on.

3) Jika komputer telah hidup, panggil aplikasi Adobe Photoshop 6.0.

Tunggulah hingga proses loading selesai.

4) Buat file baru dengan backgroud putih dengan mode grayscale,

dan tambahkan sejumlah teks hitam padanya kemudian rasterize

layer text tersebut

5) Berikan efek noise dengan memilih menu Filter>Noise>Add

Noise, set Amount ke 145 dan  Distribution to Gaussian.
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6) Gabungkan layer text dengan backgroud dengan memilih menu

Layer->Flatten Image

7) Pilih menu Filter->Pixelate->Crystallize, set Cell Size ke 3. pilih

menu Filter->Stylize->Find Edges.

kemudian Filter->Blur->Gaussian Blur, set Radius ke 0,8. putar

gambar 900 searah jarum jam dengan memilih menu Image-

>Rotate Canvas->90CW.

8) Pilih Image->Adjust->Invert untuk menukar warna dari gambar

9) Berikan efek angin Filter->Stylize->Wind dengan setting

Method: Wind, Direction: From the right

10) Putar kembali gambar ke posisi semula Image>Rotate

Canvas>90CCW.

11) Ubah mode dari gambar ke RGB agar gambar memiliki warna

dengan memilih menu Image->Mode->RGB Color.

12) Ubah komposisi warna dengan memilih menu

Image->Adjust->Hue/Saturation ( pilih  checkbox Colorize ,

Hue: 215, Saturation: 75, Lightness: 0 ).
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 BAB III

EVALUASI

A. PERTANYAAN

1. Apa perbedaan pengubahan Image size dan canvas size ?

2. Apa yang dimaksud resolusi gambar ?

3. Apa yang dimaksud intensitas ?

4. Apa yang dimaksud pallete ?

5. Apa yang dimaksud dengan Selection Tools ?

6. Buatlah modifikasi foto sehingga menghasilkan gambar foto seperti

dibawah ini!
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B. KUNCI JAWABAN EVALUASI

1. Pengubahan Image Size:

Mengubah ukuran gambar secara keseluruhan, yaitu seluruh image

akan diperbesar dan berpengaruh terhadap ukuran canvas (kertas).

Pengubahan Canvas Size:

Hanya berpengaruh pada ukuran kertas. tidak berpengaruh pada

ukuran gambar.

2. Resolusi gambar adalah : jumlah pixel per centimeter.

3. Intensitas adalah : jumlah pixel yang membentuk gambar yang dimiliki

oleh suatu gambar.

4. Pallete adalah menu dialog untuk setting yang berisi berbagai macam

alat bantu.

5. Selection Tools adalah salah satu tool yang ada pada toolbox yang

berguna untuk menyeleksi area dari suatu obyek gambar, yang

kemudian dapat dilakukan editing dan manipulasi gambar.

6. Langkah membuat modifikasi gambar foto:

a. Buka file dune.tif pada folder C:\Program File\

adobe\photoshop\sample

b. Buat obyek lingkaran dengan seleksi eliptical marquee Tools.

c. Tekan Ctrl +Shift saat mendrag seleksi, untuk memperoleh bentuk

lingkaran.

d. Klik Gradient Tool, pilih Linier  gradien pada option bar.

e. Arahkan mouse pada area seleksi drag mouse kearah horisontal.

f. Klik Filter>Render> Lens Flare untuk memberi efek cahaya

lensa pada lingkaran.

g. Tekan Ctrl+D untuk menghilangkan seleksi.

h. Buka gambar astrounout dari folder  C:\Program File\

adobe\photoshop\sample
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i. Lakukan seleksi dengan Magnetic Lasso Tool terhadap gambar

astrounout.

j. Klik Select>Invers untuk membalik seleksi.

k. Tekan delete untuk menghapus background astrounout.

l. Drag gambar astrounout ke gambar dune.tif, Bila gambar terlalu

besar edit dengan Free Transform, Yaitu: klik Edit>Free

transform, atur ukuran dan posisi yang sesuai kemudian enter.

C. KRITERIA KELULUSAN

Aspek
Skor

(1-10)
Bobot Nilai Keterangan

Kognitif (soal no 1 s/d 5)  3

Kebenaran langkah  3

Kerapian, kebersihan, ketelitian  2

Ketepatan waktu  2

Nilai Akhir

Syarat lulus nilai
minimal 70 dan
dan skor setiap
aspek minimal 7

Kategori kelulusan:

70 – 79 : Memenuhi kriteria mininal. Dapat bekerja dengan bimbingan.

80 – 89 : Memenuhi kriteria minimal. Dapat bekerja tanpa bimbingan.

90 – 100 : Di atas kriteria minimal. Dapat bekerja tanpa bimbingan.
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BAB IV

PENUTUP

Demikianlah modul pemelajaran Mengoperasilkan Software Pengolah

Gambar Raster (Digital Imaging) dengan Adobe Photoshop 6.0.

Materi yang telah dibahas dalam modul ini masih sangat sedikit. Hanya

sebagai dasar saja  bagi peserta diklat untuk belajar lebih lanjut. Diharapkan

peserta diklat memanfaatkan modul ini sebagai motivasi untuk menguasai

software pengolah gambar raster lebih jauh sehingga peserta diklat dapat

merancang dan memodifikasi berbagai macam tampilan gambar yang

dikehendaki.

Setelah menyelesaikan modul ini dan mengerjakan semua tugas serta

evaluasi maka berdasarkan kriteria penilaian, peserta diklat dapat dinyatakan

lulus/ tidak lulus. Apabila dinyatakan lulus maka dapat melanjutkan ke modul

berikutnya sesuai dengan alur peta kududukan modul, sedangkan apabila

dinyatakan tidak lulus maka peserta diklat harus mengulang modul ini dan

tidak diperkenankan mengambil modul selanjutnya.
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